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1. Overview
This document is intended for system administrators and clinic managers. It summarizes new features and
describes the latest technical requirements for installing or upgrading to athenaPractice v25.

Updates in this release
Installation and Upgrade
l Installation and upgrade guidance: We've organized the content in this document so that any

installation or upgrade changes appear first. Your organization may need this information to install this
product version. See Installation and upgrade for details.

What's New
Access What's New for an overview of the features and enhancements appearing in this release.

l Medication, prescription, and chart updates: Changes to provider workflows tend to have the most
impact on clinical staff and may require internal training on your part. See Medications and prescribing
followed by General chart and system features for these changes.

l Administration: Check for changes to the workflows clinic administrators follow to maintain users and
system settings. See Administration for details.

l Reports and MEL updates: Access new reports or review MEL changes.

l Patient registration: Review changes to front desk staff workflows. See Patient registration.

Fixes and Known Issues
l Fixes and known issues: See v25 Fixes or Known Issues for corrections or fixes in progress.
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2. Installation and Upgrade
In this section, review changes that may impact the v25 upgrade process.

Important
Before upgrading your production instances to v25, we highly recommend upgrading to v25 in a
test environment first to verify its functionality with any third-party applications you use. See Test
Environment Setup Guide for athenaPractice v25.

If you have any questions about the compatibility of a third-party application with v25, please
reach out to your third-party application vendor to verify their application’s compatibility with
this release.

l Access v25 product files and documentation

l Review upgrade path guidance

l Review supported software platforms

Additional installation and upgrade requirements
l LDAPS

l SQL Server 2022

l Web browser requirement

l Uninstall previous client

l SQL Server compatibility level

l Two load balancers now supported

l Do not delete GEDeployment folder

l Known issues for installation and upgrade processes

l Monthly Knowledgebase and OBS Terms updates

l Clinical content updates

l EDI plug-ins

l ezAccess
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l JBoss EAP upgrade

l JBoss directory change
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2A. Access product files and documentation
Download product files and documentation from the Customer Portal.

l To determine your minimum hardware requirements for this release, see Calculating Hardware Requirements for

athenaPractice (Microsoft Excel spreadsheet).

l For supported software and configuration information, see Configuring Environments for athenaPractice.

l For installation and maintenance instructions, see Install and Maintain athenaPractice v25.

l For upgrade and maintenance instructions, see Upgrade and Maintain athenaPractice v25.

2B. Upgrade path support
You can upgrade directly to v25 from v23, v23.1, v23.2, or v24 (with or without hotfixes applied).

If you have a version earlier than v23.x, you must run the athenaPractice database upgrade portion of the
upgrade to v23.x before upgrading to v25. However, you can run the upgrades back-to-back without
separate downtimes.

Note
If you use the Chart module to record medications, you must activate Medication Management on
v20.1 before upgrading to any later version of this software. We no longer support the use of
"classic" medication screens to record prescriptions or medications.

Contact Services if you have questions about your upgrade path.

2C. Software platforms
This version was validated with the following software platforms at the time of initial release.
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2D. LDAP over SSL (LDAPS)
We strongly recommend that you use LDAPS for this release. For details, see “Plan/prepare for security
model changes” and "Configure security" in the Installation or Upgrade guide.

2E. SQL Server 2022
athenaPractice v25 supports SQL Server 2022. If you choose to use SQL Server 2022, note that the Legacy
Cardinality Estimation value is OFF by default. If you observe any performance degradation with
athenaPractice v25 on SQL Server 2022, consider changing the Legacy Cardinality Estimation value to ON.

2F. Web browser requirement
athenaPractice v25 requires that you install Microsoft Edge as your default web browser.

Note
The athenaPractice v25 client now runs as a standalone desktop application instead of in a web
browser.

2G. Uninstall previous client
To upgrade the athenaPractice client, we recommend using the Control Panel to uninstall the previous
version of the athenaPractice client and then installing the athenaPractice v25 client from setup.exe or
athenaPractice_Client.msi through the network share drive (<drive>:\CentricityStaging\CPS_Client) path.

2H. SQL Server compatibility level
Changing the SQL Server compatibility level to lower than 130 will impact the behavior of athenaPractice
applications and queries. We recommend that you set the SQL Server compatibility level to 130 or higher.

2I. Two load balancers now supported
Previously, in environments with multiple GUI servers, athenaPractice supported the installation of a single
load balancer that distributed client requests across the GUI servers.
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To improve the reliability of athenaPractice, you can now install another load balancer so that if the first
load balancer fails, traffic can be routed to the second load balancer. athenaPractice does not support more
than two load balancers.

When using dual load balancers, only one of them will be active at a time. A load balancer alias must be set
up to point to the active load balancer. All clients will use a URL based on the load balancer alias, which will
automatically direct them to the active load balancer.

If the active load balancer fails, it is the responsibility of the system administrators to monitor and detect
the failure. The following errors may indicate a load balancer failure while a client is open or trying to open.

Once a load balancer failure is detected, a system admin must manually switch the load balancer alias to
the other load balancer, making it the new active load balancer. Clients will continue using the same URLs
based on the load balancer alias and won't need to make any changes.
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If the switch happens quickly enough, the clients' retry logic should be able to reconnect to the new active
load balancer. In the worst-case scenario, users may need to exit and restart the client, but no reinstallation
or configuration changes are necessary.

For more information about setting up a load balancer alias, see the “Apache load balancers” section of the
Upgrade or Installation Guide.

2J. Independent load balancer installation
In previous versions of athenaPractice, the load balancer was tightly integrated with the application and was
installed along with other JBoss servers. This meant that when a load balancer required an update, all
servers needed to be reinstalled.

To allow for greater flexibility and easier management of load balancers, load balancers are now installed
independently of the JBoss servers. This change also allows for updates and rollbacks of load balancer
versions irrespective of the status of other servers.

Important:
With this change, clicking Validate & Install no longer installs the load balancer. To install or
upgrade a load balancer, you must now click LoadBalancer Updater.

Update to upgrade and installation procedure

Now, when you click the Validate & Install button in Server Configurator, only the JBoss servers are
installed. If you upgrade or install two or more GUI servers, a load balancer upgrade or installation is
required, and the Client URL field at the bottom of the screen now displays “Multiple GUI Servers –
Undetermined.” The client URL will be available only after the load balancer upgrade or installation is
complete.
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If upgrade or installation of a load balancer is required, you must complete the following additional steps:

1. If you didn’t already Validate & Add the load balancer(s) and load balancer alias (which is required if
using two load balancers), do so after the Validate & Install step for JBoss servers is complete. The
Server Validation Result grid now shows the Load Balancer version (if any).

2. Click the new LoadBalancer Updater button at the bottom of Server Configurator.

The version of the load balancer is displayed.

3. Click Yes to continue.
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A message displays to indicate that the servers will not be available during installation.

4. Click Yes again to start the load balancer installation.

5. If you are installing dual load balancers, you must update the URL of your clients to point to the load
balancer alias:

a. Once the load balancer installation is complete, note the value of the Client URL field:
https://<aliasServerName>/9443/<dbName>/cps.

b. On each client machine, right-click the athenaPractice Client shortcut and click Properties.

c. In the Target field, enter the new URL that points to the load balancer alias and click OK.

Note: If you don’t complete this step, you will receive the following error while upgrading the client:

2K. Dual FQDN support
The FHIR API server now supports dual FQDNs: one for internal communication on port 9443 and another
external, public FQDN without port numbers. With this change, the FHIR API server can now respond to
requests with or without port numbers in the URL.

To enable a public-facing FQDN: 
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1. In the API registration tool, provide the Application Username, Application Password, and Database values and

click Validate.

2. Once details of the server appear under "Server Details," click Azure AD Login and enter your tenant username

and password.

3. Select the Configure Public Endpoint check box.

4. Enter your public-facing FQDN value in the Server FQDN field and a Server Port value. (By default, this is set to

9443.)

5. Click Configure.

6. Once the configuration completes, click the Configure button under the "Configure Patient Access" section.

When the configuration completes, the public FQDN value is updated with sitetype 112 in the INETSERVICES table

of the database.

2L. Run API Registration Tool
During upgrade or installation of v25, ensure that you run the API Registration Tool from Server
Configurator.

2M. Do not delete GEDeployment folder
After upgrading to or installing v25, do not delete the ..\GEDeployment directory. This directory now
contains files that are necessary for TLS/SSL certificate installation.
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2N. Known installation/upgrade issues
KA Issue Description Workaround

113927 During client installation, the following error
appears if the Root CA certificate was not
installed on client machines: 

After logging in to the athenaPractice client, the
following message also appears if the Root
CA certificate was not installed.

Install the Root CA certificate:

1. On each client machine, run Windows
Powershell 5.1 as an Administrator.

2. Navigate to this athenaRootCA Certificate
folder: \staging_dir\CPS_
Client\ISSetupPrerequisites\athenaRo
otCA Certificate.

3. Type .\ installrootca_crt.bat and press
Enter.
The client certificate will be imported.

114257 While upgrading the client from an earlier v25
build to a later one through the Update page or
while installing EDI plug-ins, you might receive
the following script error: 

This error does not affect the installation. Click
Yes or No to proceed.
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KA Issue Description Workaround

This error does not display if you uninstall and
reinstall the client or upgrade clients through
GPO push.

69025 After upgrading to athenaPractice v25, we
recommend running the CPNS_Fix SQL script
to improve performance of the application.

See the KA for details.

86508 During client upgrade, a message may appear
stating, "The installer is unable to uninstall the
previous version of athenaPractice. Please go
to Control Panel/Add Remove Programs and
uninstall athenaPractice." This message occurs
randomly.

ClickOK and continue to install the client. Or,
you can uninstall the existing client from the
Control Panel and proceed with the new client
installation.

While upgrading the client, you will receive a
security alert if you installed dual load balancers
and didn’t update the Target of the
athenaPractice Client URL.

1. On each client machine, right-click the
athenaPractice Client shortcut and click
Properties.

2. In the Target field, enter the URL from the
bottom of Server Configurator that points
to the load balancer alias:
https://<aliasServerName>/9443/
<dbName>/cps.

3. ClickOK.

2O. Monthly updates
Keep current on regularly updated content such as Knowledgebase and OBS terms. Find these updates on
the Customer Portal under athenaPractice > Product Downloads > Monthly Updates.
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Important
These updates should be completed after hours. For ICD and CPT code updates in multi-tenant
environments, additional scheduling considerations apply. For more information, see KA 66429 or
the Release Notes for ICD and CPT Codes.

2P. Clinical content
If you use SimpleChart, CC Basic, or CC Specialties, you must install the v25 versions of these packages with
this release.

Important

After installing HTML forms, always clear your cache by clicking File > Clear Html Cache in the
application. Also use this new Clear Html Cache option if you encounter any issues with an HTML
form. Clearing your IE cache no longer resolves HTML form issues.

For more information, see the Release Notes for the clinical content packages on the Customer Portal (under
athenaPractice > Product Downloads > Clinical Content).

2Q. EDI plug-ins
Your clinic's plug-ins must be reinstalled after upgrade.

If you use the RelayHealth EDI Plug-in, you will also need to install the Amazon Corretto 8 JDK from the
Product Update page.

For enhanced security, Microsoft Entra ID-enabled plugins are now available from the Product Updates page
and non-Microsoft Entra ID EDI plugins are not supported. See the "Prepare for security model changes"
section of the Upgrade and Maintain athenaPractice Guide for more information about implementing
Microsoft Entra ID or contact Support for assistance.

2R. ezAccess
If you are upgrading athenaPractice without changing servers, IP addresses, or firewalls, your custom portal
buttons will no longer appear after the upgrade. You can request support for replacing the portal buttons by
emailing support@ezaccessmot.com with a date and time of your athenaPractice upgrade.
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If you are changing servers, IP addresses, or firewalls, a portal reconfiguration is required. Contact ezAccess
at support@ezaccessmot.com before upgrading athenaPractice to schedule the portal reconfiguration. This
will minimize downtime for clinic staff and patients.

This work is billable, so a quote from athenahealth is required. Once the quote is signed, athenahealth will
send a PO to ezAccess/MOT staff to authorize the work. For more assistance, please contact your
athenahealth CSM or your athenahealth Value-Added Reseller.

2S. JBoss EAP upgrade
In v25, we upgraded JBoss EAP from 7.4.0 to 7.4.17 GA with 64-bit OpenJDK 17.0.14. This upgrade includes
security fixes, which you can review from the Red Hat website.

2T. JBoss directory change
The JBoss directory no longer contains a jdk folder. Files previously located in ...Centricity Practice
Solution\jboss\jdk\jre\ are now located in ...Centricity Practice Solution\jboss\jre\.
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3. What's New
Review the following sections for a summary of the enhancements in this release.

l Medications and prescribing

l General system and chart updates

l Administration

l Reports

l MEL updates

l Patient registration
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3A. Medications and Prescribing
Review medication and prescription workflow enhancements appearing in this release.

Note
The following enhancements may impact they ways in which your providers prescribe.
Collaborate with your education team to prepare providers for these changes.

l Canceled prescription indicators

l Medication truncation in complex meds

l Prescription fill status now stored on the database

l Prescription preference update

l Send patient’s BSA to Medication Management

l SQL query to identify potential mismatched patients on incoming renewal requests

l Whitelisting update
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Canceled prescription indicators
Previously, if you prescribed a drug for a patient and then canceled the prescription, two actions would
display for the prescription within its history, which could appear as if the drug had been prescribed twice.

Now, canceled prescription entries only appear once and indicate that a cancellation has occurred, allowing
you to prescribe the drug again should you need to.

In Medications, expand a drug to view its history. If canceled, an entry appears with a Canceled status and
includes the cancellation date.
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Field limit indicator for medication
instructions
At times, the level of information that appears in Instructions for medications can exceed the 1400-
character limit for this field. Previously, if the instructional text exceeded this limit, it would appear
truncated.

Now, if the text appearing in the Instructions field exceeds the field limit, a three-dot icon appears to visually
indicate this limitation.
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Prescription fill status now stored on the
database
In 2022, DrFirst released a feature to retrieve the fill status of prescriptions from the pharmacies that make
this information available. At the time of that feature release, most large pharmacy networks did not provide
prescription fill status information.

To prepare for a time when this information is more widely available from pharmacies, we’ve ensured that
our systems can reliably retrieve and store this information from Medication Management (DrFirst) on the
database.
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Prescription preference update
In Medication Management preferences, under Prescribing, we recommend that you enable Allow a
provider to approve a prescription without entering a signature password. This option allows providers
to prescribe non-controlled substances with greater ease.

Important
We recommend that you enable practice settings based on your clinic’s local laws and
regulations. Consult with local agencies and legal experts to determine the settings to use.

Send patient’s BSA to Medication Management
If you record patient height and weight information in the Vital Signs-CCC form, the system now
synchronizes the patient’s Body Surface Area (BSA) and displays it in the patient banner to the right of
Height and Weight values in Medication Management.

Note
The BSA Calc value in the Vital Signs-CCC form does not automatically display a calculated BSA
value. You must click BSA Calc to generate this value. Although the Vital Signs-CCC form is
frequently used to calculate a patient’s BSA, you can use any form that calculates a patient’s BSA
to display this value in Medication Management.

Note
BSA calculations help when prescribing certain medications, such as chemotherapy or pediatric
drugs, more precisely. The BSA calculated in CCC forms does not replace the BMI field in a
patient's chart.
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SQL query to identify potential
mismatched patients on incoming renewal
requests
Now, you can run a report that lists patients that may have been incorrectly matched with inbound
prescription refill requests.

The query output includes patient information from the incoming pharmacy message matched against
information from the patient's registration form. It will indicate elements that differ between the pharmacy
request and patient registration records, such as date of birth, first and names, gender, and the patient's zip
Code. This will help you to determine whether a mismatch occurred.

Prerequisites
l You must have SQL access to run this report.

l See 'Run the report' for access details.

Run the report
For report details, see ‘How can I get a list of existing aliases from Med Mgmt to review patients who may
have been matched incorrectly?’ on the Success Community.

Review results
The output contains a list of possible mismatches based on the patient's birth date, first name, last name,
gender, and zip code. The patient’s registration details are compared against the most recent pharmacy
messages.

Correct manual mismatches
If a patient has been matched incorrectly:

l Open a support case to request unlinking the patient from the prescription. See KA 92586 for details.

l In the support case, include your Practice User Name.
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l Include a completed and signed copy of the Technical Response Request and Waiver with the
following information: Patient Names, DOBs, Sex, and the patients who were incorrectly matched.
Complete the form by including information in the remaining required fields.
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Domain-based network update
This year, DrFirst is migrating Rcopia (Medication Management) to an AWS cloud solution. To ensure
continued access from your organization’s firewall, we recommend that your IT staff use the following
DrFirst domain: *.DrFirst.com.

If your organization is already using *.DrFirst.com, then no additional action is required on your part.
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3B. General System and Chart
Updates
Review chart and system enhancements that may impact providers and other users within the system.

l Audit trail for Order codes

l Clear HTML cache updates

l Decommission AUC with Change Health

l Electronic Case Reporting (eCR) updates

l Encounter date and time in exported clinical visit documents

l File In Error: New chained medication notifications

l Growth chart calculation for weight, BMI, and head circumference

l HCC categories and coefficients in patient charts

l HCC information in patient demographics

l HCC elements in search results

l HCC gap and risk scores in inquiries

l HCC gap and risk scores on patient banner

l HCC gap and risk scores on reports

l HCC: New Problem and Edit Problem updates

l In-App Notifications

l Order history enhancement

l Product version on application screens

l Service requests — New order codes

l Sex parameters in patient observations

l Travel history

l Update Orders UI enhancements
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Audit trail for Order codes
We've introduced a new audit type, "Order Codes Change," to track instances when users add, modify, or
remove order codes. This workflow specifically impacts the administrative modules for order codes and
applies to all three order types: Services, Tests & Procedures, and Referrals.

The system now generates audit entries for the following actions:

1. Inserting a New Order Code: In the Order Codes table, when a user selects any category and then clicks
New in the codes section, the system records an entry.

2. Modifying an Existing Code: If a user selects an existing code, clicks Change, and updates the code
details, the system generates an entry.

3. Removing a Code: The system also generates an entry when a user selects a code and then clicks
Remove.

The system records these actions in Audit_Event and Audit_Event_Details tables.

You can run a report of these events by navigating to Chart Reports > Audit Reports. Select the
appropriate audit type, configure the date range, and include contributing users. Click Print or Preview to
access report details.

Clear HTML cache updates
If you have upgraded or modified HTML files on your JBoss application server, it is essential to clear the
HTML cache for each user or client instance accessing those files. Additionally, if the Webview2 client cache
becomes out of sync on the JBoss server, clearing the HTML cache can help resolve this issue.

Important
Before clearing the HTML cache, close the application first and then log back in.

You can now clear the HTML cache not only from the Chart modules but also directly from the main
application menu by selecting File > Clear HTML Cache.
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l When you select Clear HTML Cache from the main application menu, the CentricityCef, ChartWebView2,
and PracticeManagementWebView2 caches are cleared.

l When you select Clear HTML Cache from any of the Chart modules, the CentricityCef and ChartWebView2
caches are cleared.

Decommission AUC with Change Health
On January 1, 2024, the Centers for Medicare & Medicaid Services (CMS) paused the implementation of the
Appropriate Use Criteria (AUC) program for reevaluation and rescinded the AUC regulations at 42 CFR
414.94, reserving this section for future use. As a result, athenahealth will not be utilizing AUC with Change
Health.

To address this change, we have implemented the following measures:

l Athenahealth will stop all backend calls to Change Health if a system attempts to access the AUC service
via API.

l AUC has been disabled in the on-premises system by turning off the admin setting to prevent
reactivation.

l The AUC user interface has been removed or hidden.

These changes are intended to align with CMS's decision and ensure that AUC functionalities are effectively
disabled.
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Electronic Case Reporting (eCR) updates
To meet additional requirements for eCR, we have made the following changes in this release:

l This release uses the 3.1.8 version of the eCR Now app.

l ISO 3166 country codes are now included in the eCR CCDA document when a patient’s travel history is
recorded in athenaPractice.

l When Response Record (RR) documents are not received, you can see error events in Subscription
Monitoring.

l RR documents are now linked to the original document that triggered the eCR submission. If multiple
RRs are received for the same document, all the RRs are linked to the original document.

l If your system is set up so that RRs are not signed by default, the linked RR status is displayed so that
the user can sign the document. If your system is set up so that RRs are signed by default, the linked RR
status is marked as complete.

l In response to AIMS feedback, we are now including the provider's email and the patient's emergency
and guardian contacts, detailed race and ethnicity, occupation, occupation industry, and travel history
in the eCR CCDA.
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Encounter date and time in exported
clinical visit documents
Now, when you export the Clinical Visit Summary or transition of care documents, the encounter date and
time appears in the Encounters sections of those files.

Encounter date and time stamp in Clinical Visit Summary
In Documents, right-click an encounter document and select Create Clinical Visit Summary. In the
summary, click Save to File. Select the export destination and click OK. When you open the exported
summary, the encounter date and time now appears in the ENCOUNTERS section of the file.

Encounter date and time stamp in transition of care documents
The encounter date and time also appears in the Encounter sections of exported transition of care
documents. Right-click an order and select Create Transition of Care Document. Save to a location and
open the file. The encounter date and time appears in the Encounters section.
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File in Error: New chained medication
notifications
When filing a document in error that contains a medication within an in-progress changes, you are now
prompted to review and process these changes prior to filing in error.

When this message appears, access Medication Management from the patient’s chart and either save your
changes to sign for them or cancel your changes before attempting to file in error.

The Filed in Error (FIE) process includes this validation against related items to ensure accuracy, which
prevents users from making changes to outdated versions of documents that contain medication updates
and informs them of the Med Chain.

l When attempting to file a document in error, the system will check if the document contains medication
that has since been updated.

l If the document is not the newest version, the user will be prevented from making updates.

l A prompt will inform the user to review and process any necessary changes before proceeding with the
FIE.

User Action Required
1. When the error message appears, locate the newest version of the document.

2. Perform the Filed in Error (FIE) process on the newest version first.

3. Once the latest version has been processed, you may proceed with filing the intended document in
error.

This enhancement helps maintain data integrity and ensures that only the most up-to-date medication
records are modified.
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Growth chart calculations for weight, BMI,
and head circumference
The Centers for Disease control (CDC) in connection with the American Academy of Pediatrics (AAP) have
increased their focus on monitoring pediatric patient growth, with an emphasis on monitoring instances of
childhood obesity.

To aid in this initiative, we've enhanced the math and calculations in Weight and BMI Growth Chart features
to plot more accurate values and to display this information in percentiles. We’ve also enhanced
calculations for head circumference measurements.

Weight Calculations
Pediatric growth charts now offer visualization for weight values above the 97th percentile. We’ve enhanced
this calculation to plot more accurate values in the growth chart and to display weight information in
percentiles.

View weight calculations in the Growth Chart

In left menu of a pediatric patient’s chart, click Graphs. In Graph Observations, click Growth Chart. In
Growth Chart, click the right arrow to navigate to the Weight Chart.

In the chart, view the patient’s weight compared to the recommended weight range for patients within their
age group.

In the growth chart, click Percentiles to view the patient’s weight in percentages.
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BMI
In the Growth Chart, click the right arrow to navigate to the BMI chart. Review the patient’s BMI compared
to others in their age range. Click Percentiles to view this information in percentages.

Head Circumference
If the patient is less than 24 months of age, you can document the patient’s head circumference as an
additional measure of growth. Access Vitals in the Pediatric-CCC form to record this information.
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HCC categories and coefficients in patient
charts
In Update Problems, HCC Category and HCC Coefficient columns now appear in the problems table.

HCC Category, HCC Coefficient, and Unassessed indicators in Chart
Summary
The Chart Summary Problems pane now includes HCC Category, HCC Coefficient, and Unassessed indicator
columns.

Unassessed indicator: This indicator appears for HCC problems that have not been assessed in the current
payment year. If you hover over the indicator, the system displays the last assessed date. Once you add a
new assessment to the HCC problem, the indicator disappears.
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1. In the Chart Summary Problem pane, select an HCC problem that has an unassessed indicator.

2. Click the plus icon.

3. Click Add Assessment.

4. Enter assessment comment.

5. Choose an assessment by selecting New, Improved, Unchanged, or Deteriorated from the drop-down
list.

6. Click OK. The assessment is added and the unassessed indicator is removed.
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HCC information in patient demographics
Patient demographics now include HCC information.

l When a user accesses the HCC version of the product, the system adds new rows to patient
demographics: at least one row for a RAF score and one row for a GAP score to support the CMS-HCC
Model v28 version for the adapted year.

l When the calendar year changes, the system adds a new set of rows for the current calendar year.

l The system runs a nightly job to calculate and update HCC RAF and GAP scores.
1. If a row already exists for the current calendar year, then the row is updated.
2. If no rows exist, the system creates a new row with the latest score.
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HCC elements in search results
If your organization has enabled the display of Hierarchical Condition Category (HCC) Coefficients, you will
now see the HCC Coefficient for each diagnosis in problem search windows such as Find Problem and Quick
Search.

Important
HCC Coefficient values are always shown for the current date, regardless of the clinical date of the
active document(s).

The system retrieves HCC Coefficient values based on the patient’s age. When a patient is less than 65 years
old, the system fetches the segment value for Community Non-Dual Disabled. When a patient is 65 years or
older, the system fetches the segment value for Community Non-Dual Aged.

Note
The HCC Category will always appear on the Find Problem window.

Open the Find Problem window
1. In the patient Problem list, click (New) or (Edit) and then click (Full Reference Search).

The Find Problem window opens.

2. Enter search terms in the Search for field and press Enter. Search results appear in the list, including
the diagnosis descriptions, ICD-10 codes, HCC Categories, and HCC Coefficients.

This HCC Coefficient column also appears in the following problem search windows:
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l Find Problem in the Chart Summary problem pane

l Quick Search in the New or Edit Problem window on the Update Problems window and Chart Summary
problem pane

l Quick Search on Chart Summary problem pane
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HCC gap and risk scores in inquiries
The Inquiries module now includes additional features to find patients who have one or more high risk
chronic conditions and checks if they have care gaps to close.

Find patients with HCC Gap and Risk scores

1. In Chart, click Chart Reports from the left menu, then click Inquiries. The Inquiries window opens.

2. In Find, select Patients from the drop-down list and check the option for Search Active Patients only.

3. Set up search criteria.
a. In the first Where field, select HCC Gap Score.
b. In the second Where field, select is less than.
c. In the third Where field, enter the value to find.

4. Click Add.

5. Repeat Steps 2-4 to add HCC Risk Score.

6. Click Search
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HCC Gap and Risk scores on Patient
Banner
HCC Gap and Risk scores can now appear in the Patient Banner. As a clinic administrator, if you apply the
factory-shipped banner Patient Banner with Protocol Alert, gap and risk scores will appear in the banner.

Note: The system runs an automation script after hours to automatically recalculate HCC Gap and
Risk scores. This means that if you add a new HCC problem for a patient, the risk and gap scores
will not update until after the nightly job is completed (the score will not update immediately or
on demand).

Apply the banner 
You do not need to install a clinical kit to apply this banner. The Patient Banner with Protocol Alert is
added to the database upon installing or upgrading to this software version.

1. Access Administration. In the left menu, navigate to System > User and Resource Management >
Users > Preferences > User Preferences.

2. In User Preferences, select Patient Banner.

3. Select the user or group, deselect Use standard banner, and select Patient Banner with Protocol
Alert.

Alternatively, you can add HCC Gap and Risk scores in any banner template by updating the template to
include the following:
{HCC_SCORE("list","Risk")}

{HCC_SCORE("list","Gap")}
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HCC gap and risk scores on reports
In the Reports module, you can now run reports that show HCC Gap and Risk scores in inquiry results.

Preview or Print Patient HCC Summary

1. In Reports from top menu, click Reports. The Reports window opens.

2. Under Print Topics, go to Chart > Reports> MedicaLogic > HCC

3. Check the box for Report only on items in the inquiry results list.

4. Click Preview or Print. Preview Print Item window opens.
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HCC: New Problem and Edit Problem
updates
The HCC Category and HCC Coefficient for a problem now appears on New and Edit Problem windows. We
repositioned some fields, such as ICD-10 and Interactions to provide more space to display this information.
We've also removed the ICD 9 label and Values fields.
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Health Status Assessments
To accommodate USCDI v3 changes for Health Status Assessments, you can now record Hunger Vital Signs
and a patient's Comprehensive Universal Behavior Health Screen (CUBS) disability status, which will appear
in the Social History section of CVS, TOC, and VDT documents.

You can record Hunger Vital Signs in a new Hunger Vital Sign-CCC form by selecting from predefined
answers to questions. Both the questions and the answers correspond with LOINC codes, which appear in
the XML sections of CCDA documents. The codes in these sections will not appear in a human-readable
format. To access this information in a human-readable format, access the Social History section of a CCDA
document. The Hunger Vital Signs you recorded will appear in this section.

As a part of a behavioral health assessment, you can record a patient's CUBS disability status in a new
CUBS-CCC form. The answers you select in the form correspond with LOINC codes, which appear in human-
readable format within the Social History section of exported CCDA documents.

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com



athenaPractice v25 Release Notes 48

In-App Notifications
Now, you can access time-sensitive system notifications directly from Chart Desktop or a patient’s chart.
Click Notifications in the ribbon to view messages. When you receive new notifications, an unread

message count increments in the toolbar button.

In Notifications, get the latest updates on service outages, scheduled maintenance windows, upcoming
releases, training opportunities, and satisfaction surveys.

Notification Options
l Select All: Selects all active messages in Notifications.

l Mark as Read: Once you’ve reviewed your notifications, select individual message checkboxes or click
Select All. Click Mark as Read to hide them.

l Show All: Click to access both read and unread notifications. Previously read notifications appear in a
light gray font with checkboxes inactive.

l Refresh: The system automatically refreshes the Notifications screen every five minutes. To manually
trigger an update, click Refresh.
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Important
If you click Refreshmultiple times in succession, the system will pause each refresh for a
minimum of 10 seconds. This is to preserve system performance.

No New Notifications
If no notifications are available, a No new notificationsmessage appears.
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Order history enhancement
Previously, if you changed an order after signing and sending it, or if you made changes after an order was
completed, the system updated the order history to reflect the latest change. In these cases, the system
would only add a historical entry if the order's status changed. If you made changes to an order without
updating the order's status, the system would overwrite the previous historical entry with the latest entry.

Now, if you make any changes to an order after signing, the system adds new rows to the order's history and
retains previous historical entries.

Note
Changes to orders before they are signed are not recorded in Order History.

Additional information in order history entries
When you select an order history row, additional information now appears in the detail view if available.
New information includes:

l TOC Reason: Displays the reason for a transition of care event, if applicable.

l Admin Comments: Lists administrative comments for the order update.

l Reason for Cancellation: If canceled, displays the reason for the order cancellation, if available.
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Product version on application screens
Previously, not all application screens displayed the requisite software version and copyright details. Now,
all screens identified as requiring this information display the following version and copyright details.

© 2025 VVC Holding LLC. All rights reserved.

CPT copyright 2024 American Medical Association.

These changes will be applied to .exe and .dll files.
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Service Requests: New order codes
During an encounter, if providers request additional services to assess the social wellbeing of a patient, such
as a patient’s cognitive or functional status, the codes associated with these services are now included in
exported transition of care documents.

For a complete listing of these codes, see US Core Service Request Category Codes on the HL7 FHIR website.

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com

https://hl7.org/fhir/us/core/2023Jan/ValueSet-us-core-servicerequest-category.html


athenaPractice v25 Release Notes 53

Sex parameters in patient observations
athenaPractice patient observations now include Sex Parameter fields, which can assist providers in offering
appropriate gender-specific care.

For example, if a patient is female-to-male transgender and is early in transition, their provider may benefit
from noting that the patient requires a “Female-typical” Lab/imaging device configuration for lab
tests/diagnostic scans.

Sex parameter options include female-typical, male-typical, specified, or unknown.

Code Display Definition

female-typical Apply female-typical setting or
reference range

Available data indicates that diagnostics, analytics,
and treatments should consider best practices
associated with female reference populations.

male-typical Apply male-typical setting or
reference range

Available data indicates that diagnostics, analytics,
and treatments should consider best practices
associated with male reference populations.

specified Apply specified setting or
reference range

Available data indicates that diagnostics, analytics,
and treatment best practices may be undefined or not
aligned with sex-derived reference populations.
Additional information may be available in the form of
comments and/or observations. The terms "Other" or
"Complex" may be considered synonyms of
"Specified".

unknown Unknown The value is expected to exist but is not known.

The observation entered is included in exported encounter and transition of care documents.
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Travel History
You can now record a patient’s travel history including dates, location, and purpose of travel. If you have set
up electronic case reporting (eCR), travel history is reported as part of eCR.

To record travel history:

1. On the Chart or Registration toolbar, click Travel History .

2. Enter details about the patient’s travel history.
The travel start date, end date, and country are required for each entry. For travel within the US, the
state, city, and zip code are also required.
Each time you compete the required fields, one more row appears so you can add another entry. You
can add up to five entries at a time.

3. Click Save.
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Update Orders UI enhancements
In Update Orders, you can now associate assessed problems with an order and view associated HCC
categories when you hover over a diagnosis.

Select assessed diagnoses in the Update Orders window

1. Select a patient with some problem assessments.

2. Open the Update Orders window and click the check mark button to select the assessed diagnoses.
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New HTML5 Help system
athenaPractice Help systems now appear in a modernized, HTML5 layout, with content updates appearing
in real-time.

Previously, Help content updates could only occur prior to a release. Now the Help system is hosted
separately from the product release, allowing us to share updates in the Help at any time.

Access the Help landing page
From the main menu, click Help > athenaPractice Help. A new landing page appears with announcements
and quick links to release highlights.

You can click the athenahealth logo in the upper left corner of any Help topic to return to this page.
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Role-based top navigation menu
Hover over top navigation menu buttons to access high-level concepts by user role. From these topics,
access related links to explore further.

Search by keywords or phrases
Enter keywords or phrases in the search bar; click Search or press ENTER. Click options in results to

navigate to topics. The search bar supports special characters and partial word searches to return results.

Note
Although the search bar supports special characters, using empty parentheses followed by a
semicolon (); will trigger an error message. The search field does support search terms in
parentheses and semicolons outside of this context.
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Resource drawers
For quick access to additional resources, click headings in the bar beneath the search field. Click the drawer
heading again to close it.

Popular links
Click options in Popular Links to visit frequently accessed topics or feature updates.

Interactive announcements
In the announcement carousel, click anywhere in an announcement to jump to related topics.
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New topic layouts and tools
At the top of each Help topic, a toolbar appears with options to toggle page options, print, or navigate to
other pages.

Highlighter toggle

When you perform keyword searches, any keywords you used that appear in the topic will have yellow

highlighting. Click Toggle highlight to remove search highlighting. Click again to reapply search

highlighting.

Note
The highlighting feature only functions when you use the search bar to locate topics. If you access
a topic using methods other than keyword searches, no highlighting appears and the Toggle
highlight button is inactive.

Print

Click Print to print a copy of a topic or generate a PDF.

Note
Due to the structure within our legacy topics, the first page in Print Preview may appear blank.
Scroll down to access a preview of topic text.

Back and Forward

Click Back to navigate to the previous topic. Click Forward to move to the next topic in a sequence

of topics you've accessed.
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Note
If you haven't accessed more than one topic in a session Forward button is inactive.

Screen Help access
You can continue to press F1 to access topics specific to the screen you’re using.

Note
To access help content for DTS, perform searches in the main application Help system. Links to
Help from DTS are no longer available. Server Configurator and Server Setup help remains
unchanged.
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3C. Administration
Review enhancements in this release that may impact clinic administrator workflows.

l Exclude clinical content from CCDA 2.1 and FHIR

l New classification for order codes

l Permission to discard documents

l Social determinants of health (SDOH) configuration

l Updates to Export Admin
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Exclude clinical content from CCDA 2.1
and FHIR
As an administrator, you can select specific clinical content to exclude from CCDA 2.1 documents and FHIR
resources, as may be required by your state.

To exclude specific clinical content from CCDA and FHIR:

1. Go to Administration > System > Interoperability > State Exclusion List.

2. If needed, select ICD, CPT, NDC, or HCPCS at the top of the table to filter the list by code type.

3. Select the check boxes next to each item that you want to exclude from CCDA 2.1 and FHIR, or select the
Exclude All check box at the top of the table.

4. At the bottom of the table, select the check box to agree to exclude the selected items from CCDA 2.1
and FHIR.

5. Click Save.
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SMART on FHIR v2
Previously, we supported SMART on FHIR v1 for external applications, and we now also support SMART on
FHIR v2.

SMART on FHIR v2 offers the following benefits:

l Enhanced Scope Definitions

l Enhanced Discovery Capabilities

l Finer-Grained Resource Constraints using Search Parameters

l Improved Security and Privacy
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New classifications for order codes
When setting up order codes (under Administration > Codes > Charts > Codes & Categories , you can
now select from these classifications:

l Laboratory

l Imaging (Radiology)

l Evaluation Procedure

l Social Service Procedure

l Counselling

l Education

l Surgical Procedure

l SDOH

l Functional Status

l Disability Status

l Cognitive Status

l Other

Previously, Laboratory, Radiology, and Other were the only available order classifications.
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Permission to discard documents
Now, practices can control whether specific system users can discard chart documents. All users can discard
their own documents, but only enabled users can discard other’s documents.

When enabled for users, they can click Discard Document to end a chart update. Users without this
permission will receive a popup when attempting to discard:

Configure the Discard Document privilege for system users
In athenaPractice, access Administration. In the Administration toolbar, click Application Users. Double-
click a username in the directory. In the user detail, click the Security tab. In the Permission List, expand
Chart. Click Discard Document to toggle this permission on or off.

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com



athenaPractice v25 Release Notes 67

Removed Clinical Quality Reporting (CQR)
dependency on Qvera Interface Engine
(QIE)
In this release, QIE is no longer required for passing information to CQR. If you use CQR, you can now use
athenaPractice subscriptions to pass this information instead.

To do this, you will need to:

l Enter CQR credentials in athenaPractice

l Import new subscriptions in athenaPractice

Enter CQR credentials in athenaPractice

In athenaPractice, you will need to enter CQR credentials that were previously stored as part of the Qvera
channel.

1. In Qvera, go to Web Service Connections > Clinical Quality Reporting.

2. Copy the value of the WSDL URL and Username fields.

3. Go to Administration > System > Interoperability > Quality Reporting Configuration.

4. Enter the username, password, and ingestion URL (https://ci-
pil.cqrdt.athenahealth.com/com.ge.hcit.pil.bulkuploadwar-2.0.8-RELEASE/services/secure/bulkupload)
that you copied from Qvera.

Note: If you forgot your password, you can create a new ingestion user in CQR by navigating to
Configuration > User Management > DIS User Management.

5. Click Save.

Import new subscriptions in athenaPractice

You will need to import a new CQR subscription under Outbound Subscriptions.

1. Go to Administration > System > Interoperability > Subscription Monitoring.

2. Ensure that “Clinical Quality Measures Reporting” and “Meaningful Use Functional Measures Reporting”
both show “0” in the Jobs and Out columns. If any jobs are taking a while to process, check the Qvera
channel to determine if there are any issues before continuing.

3. Go to the Qvera channel and pause the package.

4. Go to Administration > System > Interoperability > Subscription Configuration.
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5. Click Import Subscriptions.

6. Navigate to the Subscriptions folder (.../Centricity Practice Solution/Client/Subscriptions) and select
post_cqr.xml.

7. Click Open.

8. Select Post Clinical Measures Reporting and click Enable.

After setting up the CQR subscription, check the Post Clinical Measures Reporting status and errors (under
Administration > System > Interoperability > Subscription Monitoring) to ensure it is functioning
properly.
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Added CQR 2.1 Document Type
athenaPractice is now able to generate CCDA 2.1 documents for CQR. If version 2.1 is selected (under
Administration > System > Interoperability > CCDA Version), then CCDA documents sent to CQR will now
be version 2.1 instead of 1.1.
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Restrict access to data in ezAccess
To help protect patient privacy, a patient can request that specific data in ezAccess not be viewable to
themselves or an authorized representative. For example, a patient can request that their medications not
be viewable in ezAccess.

To request that a patient record be restricted in ezAccess:

1. Log in to ezAccess as a patient or authorized representative.

2. Click Messages > New Message.

3. Select the name of the patient you want to restrict access for.

4. In the To field, select Record Restriction Request.

5. In the message, specify the user and the type of data that you want to be restricted, and then send the
message.

To restrict access to patient data in ezAccess:

1. Log in to ezAccess as an administrator.

2. Go to Manage Users.

3. Search for the user you want to restrict access for.

4. In the search results, click Select next to the user you want to update.

5. In the Enable view of field, click Modify Settings.

6. From the drop-down menu, select the patient whose record you want to restrict access to.

7. Unselect the types of information that the user should not be able to access.

8. Click Update.

When the user logs in to ezAccess and clicks View, Download, or Share Medical information, they will
not be able to see the data the restricted data for that patient.
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Social Determinants of Health (SDOH)
configuration
As an administrator, you can customize the Social Determinants of Health (SDOH) goals and interventions
that a user can add to an encounter for each SDOH problem category (such as Homelessness) on the Social,
Psych, BH Form PRAPARE tab. You can also associate interventions with orders so that when an intervention
is added to an encounter, an associated order is also added.

Customize SDOH goals and interventions

1. From Administration, go to Charts > Chart > SDOH Configuration.

2. Select an SDOH problem category on the left side of the screen or scroll to the problem category on the
right side of the screen.

3. To add goals for a problem category:

a. Click in the Goals column.

b. Select the goals that you want users to be able to add to an encounter.

c. Click Save and Close.

4. To add interventions for a problem category:

a. Click in the Interventions column.

b. Select the interventions that you want users to be able to add to an encounter.

c. Click Save and Close.

5. To associate an order with an intervention:

a. In the Associate Orders column, select the check box next to the intervention that you want to
associate with an order. When you hover over a selected check box, the order description, category
name, and order type is displayed.

b. If the intervention has more than one order that can be associated with it, a icon appears to the
right of the check box. Click to select the appropriate order.

c. On the Order Details screen, select the order to associate and click Select.

6. On the SDOH Configuration screen, click Save.
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Updates to Export Admin

Updates to Export Admin
Easier access

You can now access the Export Admin web application from the main athenaPractice menu to export
Electronic Health Information (EHI) and view the status of Electronic Case Reporting (eCR) events.

Additional configuration step required for EHI export

To configure athenaPractice to export EHI data through Export Admin, you must now specify a location for
external attachments to be exported to.

1. In Administration, go to System > Interoperability > API Server.

2. Click EHI Export Location API Server.

3. In the Notes field, specify the shared network location where you want external attachments to be
exported.

Example: \\<hostname>\nd_json

4. Click Save.

5. Restart the Qvera Service Manager.
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For complete instructions for enabling EHI data to be exported through the web application, see the
"Configure your system for Electronic Health Information (EHI) data export" section of the Upgrade guide.
For details on using the web application, see the Export Admin User Guide.

Export Admin screen changes
We made the following changes to the Export Admin tool:

l The eCR screen now contains a Patient ID column to the right of the PID column.

l On the Export Status tab of the EHI screen, you can now cancel an in-progress job by clicking the X next
to the job.

l On the Export Status tab of the EHI screen, recently created jobs are now at the top instead of at the
bottom.
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3D. Reports
Review new report locations, added reports, and reporting features.

l Audit report enhancements for routed documents

l FIE Document(s) report reinstated

l SQL Query to identify potential mismatched patients on incoming renewal requests

l Specimen information now in lab reports
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Audit events for routed documents,
updated order codes, and removed
documents
The following audit event options now appear in Administration.

l Route document: Logs document routing events and includes them in audit reports.

l Update an Order code: Logs audit events when users update order codes in Order Administration and
includes these events in audit reports.

l Remove document from desktop: Logs audit events when users remove documents from Chart
Desktop and includes these events in audit reports.

Log document routing events
In the Administration module, expand System and click Auditing. In Log Audit Events, select Route
document and click > to move it to Log and Send Audit Events.

Log order code updates
In the Administration module, expand System and click Auditing. In Log Audit Events, select Update an
Order Code and click > to move it to Log and Send Audit Events.
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Log order code updates
In the Administration module, expand System and click Auditing. In Log Audit Events, select Remove
document form desktop and click > to move it to Log and Send Audit Events.
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FIE Document(s) report
When performing a File in Error, a user can enter an FIE reason.

A report is also available to output a list of documents filed in error.

Run the FIE Document(s) report
In the Chartmodule, click Chart Reports > Reports. Expand MedicaLogic and select Audit Reports. In
Print Items, select FIE Document(s) Report. Configure the date range for the report and then click Print or
Preview.
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SQL query to identify potential
mismatched patients on incoming renewal
requests
Now, you can run a report that lists patients that may have been incorrectly matched with inbound
prescription refill requests.

The query output includes patient information from the incoming pharmacy message matched against
information from the patient's registration form. It will indicate elements that differ between the pharmacy
request and patient registration records, such as date of birth, first and names, gender, and the patient's zip
Code. This will help you to determine whether a mismatch occurred.

Prerequisites
l You must have SQL access to run this report.

l See 'Run the report' for access details.

Run the report
For report details, see ‘How can I get a list of existing aliases from Med Mgmt to review patients who may
have been matched incorrectly?’ on the Success Community.

Review results
The output contains a list of possible mismatches based on the patient's birth date, first name, last name,
gender, and zip code. The patient’s registration details are compared against the most recent pharmacy
messages.

Correct manual mismatches
If a patient has been matched incorrectly:

l Open a support case to request unlinking the patient from the prescription. See KA 92586 for details.

l In the support case, include your Practice User Name.
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l Include a completed and signed copy of the Technical Response Request and Waiver with the
following information: Patient Names, DOBs, Sex, and the patients who were incorrectly matched.
Complete the form by including information in the remaining required fields.
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Specimen information now in lab reports
Lab reports appearing in a patient’s Documents view now list specimen information if captured in the
electronic message received from a lab. This information includes the Specimen Type, the Specimen
Collection Site, and the Specimen Condition. Select a lab report in Documents to view this information
below.

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com



athenaPractice v25 Release Notes 82

3E. MEL Updates
The MEL expression language is a programming language that makes use of data symbols and functions
entered in a command line to perform actions within the system. If you or your providers use MEL to
complete tasks, review the following MEL symbol updates.

l CAN_DISPLAY_HCC_COEF

l HCC_CONTRIBUTORS

l HCC_SCORE

l LISTRXFINSAVINGLINKS (update)

l PATIENT_PRONOUN

l PROB* data symbol update
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Data (MEL) symbol changes

CAN_DISPLAY_HCC_COEF
The new CAN_DISPLAY_COEF MEL symbol returns Y or N value based on the system setting Enable HCC
Coefficient display on respective screens. This symbol allows a form to read the value and have the
flexibility to display or hide the HCC Coefficient.

type Data symbol text

syntax CAN_DISPLAY_HCC_COEF

arguments N/A

when to evaluate When Inserted in Note or Continuously

returns Y if Enable HCC Coefficient display on respective screens system setting was
enabled or else it returns N

comment This information comes from and can be change under Administration >
System > Advanced Features

example {CAN_DISPLAY_HCC_COEF}

returns

Y

This symbol can be used in other HCC symbols.

{HCC_AFTER("delimited", CAN_DISPLAY_HCC_COEF())}

returns

2004659525819830^Cancer^C80.1^^Breast, Prostate, and Other Cancers and
Tumors V24^0.1890

Note: The HCC coefficient of Cancer problem was returned at the end.

where used Chart: Letters and handout templates, text components, chart notes, and quick
text

Encounter Form Editor: Data Display items Data Display items with a Clinical
Function connection and MEL expressions

HCC_CONTRIBUTORS
The new HCC_CONTRIBUTORS MEL symbol returns the HCC Risk score or Gap score contributors. You can
format them into a list with Risk score or Gap score contributors in a line or output the same information in
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a delimited format.

type Data symbol function

syntax HCC_CONTRIBUTORS(list_type, HCC_input_type, year)

arguments list_type (Optional)

HCC_input_type (Optional)

Year (Optional)

List format:

list - List Risk score
contributor, Gap score
contributor for the current
Patient.

delimited - Delimited return
risk and gap score
contributors, rows separated
by pipes (|), fields separated
by carets (^).

risk - returns the value of Risk
score.

gap - returns the value of Gap
score.

both - returns the value of
both Risk and Gap scores.

If any other character is
specified or if this argument is
omitted, the default list is
returned (both).

Payment year

when to evaluate Continuously

returns Active problems, including changes from the current chart update

comment list is the default argument for the list_type parameter.

both is the default argument for the HCC_input_type parameter.

current year is the default argument for the Year parameter.

The following fields are returned by HCC_CONTRIBUTORS
("DELIMITED","BOTH","YEAR"):
sprId^icd10Code^problemDesc^hccCategoryCode^hccDesc^contribFactor^RISK/GAP
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example {HCC_CONTRIBUTORS("LIST","RISK","2023")}

returns

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24 RISK COEF -
0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24 RISK COEF -
0.2570

{HCC_CONTRIBUTORS("LIST","GAP","2023")}

returns

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24 EFFECTIVE
GAP - 0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24 EFFECTIVE
GAP - 0.2570

{HCC_CONTRIBUTORS("LIST","BOTH","2023")}

returns

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24 RISK COEF -
0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24 RISK COEF -
0.2570

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24 EFFECTIVE
GAP - 0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24 EFFECTIVE
GAP - 0.2570

{HCC_CONTRIBUTORS("DELIMITED", "RISK","2023")}

returns

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic Infections
V24^0.1870^RISK

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other Cancers
V24^0.2570^RISK

{HCC_CONTRIBUTORS("DELIMITED","GAP","2023")}

returns

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic
InfectionsV24^0.1870^GAP

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com



athenaPractice v25 Release Notes 86

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other Cancers
V24^0.2570^GAP

{HCC_CONTRIBUTORS("DELIMITED","BOTH","2023")}

returns

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic
InfectionsV24^0.1870^RISK

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other Cancers
V24^0.2570^RISK

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic
InfectionsV24^0.1870^GAP

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other Cancers
V24^0.2570^GAP

where used Chart: Letters and handout templates, text components, chart notes, and quick text

Encounter Form Editor: Data Display items Data Display items with a Clinical
Function connection and MEL expressions

HCC_SCORE
The new HCC_SCORE MEL symbol lists the Risk score and Gap score information, including the HCC model,
version and segment name details. You can format them into a list with Risk score and Gap score in a line or
get the HCC model, version, segment name, risk score and gap score in a delimited format.

type Data symbol function

syntax HCC_SCORE(list_type, HCC_input_type, year)

arguments list_type (Optional)

HCC_input_type (Optional)

List format:

list - List Risk score, Gap score for
the current Patient.

delimited - Delimited shall return
HCC model, version, segment
name, risk and gap score details,
rows separated by pipes (|), fields
separated by carets (^).

risk - returns the value of Risk
score.
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Year (Optional)

gap - returns the value of Gap
score.

both - returns the value of both
Risk and Gap scores.

If any other character is specified
or if this argument is omitted, the
default list is returned(both).

Payment year

when to evaluate Continuously

returns Active problems, including changes from the current chart update

comment list is the default argument for the list_type parameter.

both is the default argument for the HCC_input_type parameter.

current year is the default argument for the Year parameter.

The following fields are returned by HCC_SCORE("DELIMITED","BOTH","YEAR"):
model^version^segmentName^riskScore^gapScore

example {HCC_SCORE("list", "risk", "2023")}

returns

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24 RISK
COEF - 0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24 RISK
COEF - 0.2570

{HCC_SCORE("list", "gap", "2023")}

returns

Chronic bronchiolitis obliterans (ICD10 J42) Opportunistic InfectionsV24
EFFECTIVE GAP - 0.1870

Heart cancer (ICD10 C38.0) Colorectal, Bladder, and Other Cancers V24
EFFECTIVE GAP - 0.2570

{HCC_SCORE("delimited", "risk", "2023")}

returns

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic
Infections V24^0.1870^RISK

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other
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Cancers V24^0.2570^RISK

{HCC_SCORE("delimited", "gap", "2023")}

returns

2006735379056800^J42^Chronic bronchiolitis obliterans^6^Opportunistic
InfectionsV24^0.1870^GAP

|2007165029133710^C38.0^Heart cancer^11^Colorectal, Bladder, and Other
Cancers V24^0.2570^GAP

where used Chart: Letters and handout templates, text components, chart notes, and quick
text

Encounter Form Editor: Data Display items Data Display items with a Clinical
Function connection and MEL expressions

LISTRXFINSAVINGLINKS (update)
The LISTRXFINSAVINGLINKS MEL symbol was originally designed to return prescription information if
prescriptions had RXWISE coupons associated with them. Our system no longer uses RXWISE, as a coupon
system is now available through the Medication Management portal.

PATIENT_PRONOUN
The new PATIENT_PRONOUN MEL symbol returns the patient's pronoun.

type Data symbol text

syntax PATIENT_PRONOUN

arguments N/A

when to evaluate When inserted in note or continuously

returns The current patient's pronoun

comment This information comes from and can be changed on the Registration Patient
tab. Click Change to view or change registration data.

example {PATIENT.PRONOUN}

returns

him

where used Chart: Patient banners, headers and templates for letters and handouts, text
components, chart notes, and quick text

Encounter Form Editor: Data Display items with Patient Attribute connections,
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visibility conditions, and MEL expressions

PROB* data symbol update
The following data symbols were updated to return the HCC category and HCC coefficient values for relevant
HCC problems when the "hcc" argument is specified.

l PROB_ACTIVE

l PROB_AFTER

l PROB_LIST_CHANGES

l PROB_NEW

l PROB_PRIOR

l PROB_REMOVED

Note: If the “Enable HCC Coefficient display on respective screens” option is not selected in Administration
> System > Advanced Features, the HCC coefficient will not be returned.

Example 1: 

{PROB_ACTIVE("list", "", "", "hcc")}

returns

Stomach cancer (ICD10-C16.9) Lung and Other Severe Cancers V24 HCC Coefficient - 1.0750

Brain cancer (ICD10-C71.9) Lymphoma and Other Cancers V24 HCC Coefficient - 0.5950

Example 2: 

{PROB_AFTER("list", "probtype", "com", "", "", "hcc")}

returns

Fever (ICD10-R50.9) -- test non hcc

Stomach cancer (ICD10-C16.9) -- test stomach Lung and Other Severe Cancers V24 HCC Coefficient - 1.0750

Example 3:

{PROB_LIST_CHANGES("Delim","Full","HCC")}

returns

Added new problem of Stomach cancer (ICD10-C16.9) Lung and Other Severe Cancers V24 HCC Coefficient -
1.0750

Added new problem of Fever (ICD10-R50.9)
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Assessed Fever as improved

Assessed Stomach cancer as unchanged

Example 4: 

{PROB_NEW("list", "dat", "com", "hcc")}

returns

08/29/2023 Stomach cancer (ICD10-C16.9) -- test HCC Lung and Other Severe Cancers V24 HCC Coefficient -
1.0750

08/29/2023 Fracture of alveolus of left mandible, subsequent encounter for fracture with routine healing
(ICD10-S02.672D) -- test

Example 5:

{PROB_PRIOR("list", "probtype", "com", "", "", "hcc")}

returns

Fever (ICD10-R50.9) -- test

Stomach cancer (ICD10-C16.9) -- test Lung and Other Severe Cancers V24 HCC Coefficient - 1.0750

Example 6:

{PROB_REMOVED("delimited", "dat", "com", "hcc")}

returns

Dx of^Stomach cancer^ICD-151.9^test^09/01/2023^09/04/2023^S^ICD10-
C16.9^2009156478158560.000000^Lung and Other Severe Cancers V24^1.0750
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3F. Patient Registration
Review enhancements that may impact front desk staff workflows.

l New image capture in Registration

l New patient registration fields

l Patient sexual orientation, gender identity, and pronouns
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New image capture in Registration
We added a new method for capturing photos in Registration.

Benefits of the new image capture method are:

l Webcam image capture now works with Citrix and RDP. Previously, the webcam image capture did not
work with newer versions of Citrix or RDP.

Note: To use a webcam with RDP, the client system must have Remote Desktop Services with:

l Remote Desktop Licensing

l Remote Desktop Session Host

l Fewer clicks are required to capture an image.

l Camera settings are saved for each user. Previously, the settings would be reset once the user logged
off.
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Note
The existing image capture workflow accessed through the Get Photo button is still available and
has not been changed.

To use the new image capture:

1. Open a new or existing patient record in Registration.

2. Click Advanced Photo.

3. Select the image source:

l Clipboard – to paste an image copied from another program

l File – to use a saved image

l WebCam – to capture a video snapshot of the patient using a connected WebCam

l Scanner – to scan an ID using a connected scanner

Note: The scanner option does not work with Citrix or RDP.

4. Once you paste, select, or acquire the image, edit it as needed. If you select the Manual tab, you can
crop and rotate the image in any direction.

5. Click OK.

Log file
When you use the new image capture, an ImageCapture.Log file is added to <drive>:\Users\<user
name>\AppData\Local\Centricity\Logs\.
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New Patient Registration Fields
athenaPractice now includes the following registration information in Chart Summary and CCDA exports,
and has additional fields to comply with USCDI v3 requirements.

l Related person’s relationship from a patient contacts

l Occupation

l Occupation Industry

l Tribal Affiliation

l Date of Death

l Patient Guardian Name

l Emergency Contact

When this information is included in a registration form, it also appears in the Patient Header section of
transition of care documents and other relevant CCDA document exchanges.

To support USCDI v3, we’ve added the following fields to patient Registration forms:

Occupation and Occupation Industry
Two new fields appear in the Additional tab under Additional Employment Information to capture a
patient’s Occupation and Occupation Industry.

Important
Unlike the Occupation field that appears under Employment Information, which is a free-text
entry field, the new Occupation field has a library of coded options to select. You must use the
Occupation field under Additional Employment Information to include a patient’s occupation
in exported chart documents.
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Tribal Affiliation
A new Tribal Affiliation field appears in the Patient tab. Click the three-dot menu to select the affiliation.

Guardian and Emergency Contact options
Now, options appear in New Contact to indicate whether a contact is a Guardian and/or an Emergency
Contact. When selected for a contact, this information is included in contact details and is included in
exported chart documents.
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Patient sexual orientation, gender
identity, and pronouns
Patient registration forms now include options to record a patient’s gender identity, sexual orientation, and
preferred pronouns. When you record gender identity and sexual orientation information for a patient, they
are included in exported clinical visit summaries and transition of care documents.

Access Birth Sex, Gender Identity, Sexual Orientation, and Pronoun fields
In the Patient tab of a registration form, locate Birth Sex, Gender Identity, Sexual Orientation, and
Pronoun fields. Select the values indicated by the patient.
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4. Fixed in v25
Feature KA Issue Description Resolution

Administration 86327 When users navigated from a patient's chart to Administration
and then back to a chart, a system crash occurred.

These crashes no longer occur when navigating from
chart to Administration and then back to the chart
module.

Administration 63341 The feature to automatically sync user groups was causing
user logins to fail.

This issue is resolved.

Administration 116381 After v22, the Patient Access Log in the Administrative folder
no longer included the same level of detail.

The Patient Access Log now includes the same level of
detail that it did for v22.

Administration 122165 When attempting to complete a chart merge with the option to
delete the source chart, users received an error that the
source chart could not be deleted. This only occurred for
patients with eCR information.

These errors no longer occur.

Billing 126170 The PatientPaymentAutopost plug-in was not always
populating the credit card type value found in the payment file
to Payment Entry.

If the card type value is available in the payment file, the
plug-in copies it into Payment Entry.

Billing 64477 In some cases, batch handling errors were occurring due to
an incorrect configuration value ('True' instead of 'true').

This issue is resolved.

Billing 105944 Encounter documents for refill requests were failing to open
when clicked.

Encounter documents for refill requests now open as is
expected.

Billing 112856 The med list ID values appearing in the MID data field under
Insurance Carriers Order Category Default Disposition were
invalid.

The issue causing invalid med list IDs to appear has
been corrected.

Billing 81316 Duplicate charges and payments were appearing on
statements when printing statements on demand from the
billing module.

Duplicate charges and payments no longer appear
when you print billing statements on demand.
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Feature KA Issue Description Resolution

Billing 116059 Appointment status was not changing from Arrived to
Complete when users entered charges.

Now, when you enter charges for an appointment, the
appointment status automatically updates to Complete.

Billing 116271 Visits were not changing to unchecked after a ticket was
batched.

Visits are automatically unchecked after a ticket
batches.

Billing 116768 When you replaced a procedure code by typing over it, the
code you typed over was not deleted and no additional
diagnosis pointers were included for the new code entered.

When you type over a procedure code, the code you
overwrite is deleted and new diagnosis pointers are
included.

Billing 116341 When you retrieved an exception row from a fee schedule
within a visit, the application was returning all rows from the
fee schedule.

The application only returns the exception row you
request.

Billing 116422 At times, the Supervising Provider field within billing tickets
included referring providers.

The Supervising Provider field only includes
responsible providers or other billable providers, as
designed.

Billing 116774 When retrieving charges, the Contract Type did not appear in
the Charges 2 tab.

The Contract Type now appears in this tab as expected.

Billing 116904 When patients had multiple entries for the same insurance
carrier but with different policies, the system was pulling the
oldest policy number for the carrier on the visit and used the
first carrier entry listed.

The system now uses the carrier selected and its policy.

Billing 116979 Voided procedures were appearing on claims, electronic and
paper, causing rejections.

Voided procedures no longer appear on electronic or
paper claim

Billing 116984 In rare cases, the previous patient's insurance was appearing
on the current patient's flowsheet.

This issue is resolved.

Billing 75275 At times, the billing grid would fail to refresh after clicking
Retrieve Charges.

The billing grid refreshes after clicking Retrieve
Charges.

Billing 117094 Users were unable to delete a visit with closed batches, even
when the batch closing override was on.

The system was preventing this because in some
cases, the selected item was in use by the system.
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Feature KA Issue Description Resolution

Billing 117422 When users performed searches in the collections module,
searches were not returning the correct visits.

Searches in collections now retrieve related visits as
expected.

Billing 117956 When users changed the DOS From value to 'On Charge' for
hospital visits that also had incorrect DOS dates, users were
receiving erroneous alerts that the fee schedule was
changing.

This fee schedule alert no longer appears in these
instances.

Billing 118008 When bulk retrieving charges in the billing system, users
were being prompted several times to acknowledge the
application of a deposit across multiple visits instead of just
once.

Users are prompted only once to acknowledge a
deposit applied across multiple visits.

Billing 118268 In Billing, the Resource field was blank if criteria was set to
only show visits with external charges.

Resource information appears if available.

Billing 120575 In some cases, when users added charges and marked Yes
for billing, added charges were not appearing in claims.

Added charges now appear in claims.

Billing 117988 Users were able to change the responsible provider on
closed batch visits by accessing Registration from a visit,
saving, and exiting. This created problems for accuracy in
historical reporting.

Users can no longer change the responsible provider
on closed batch visits.

Billing 117395 In some cases, the Visit Owner was not appearing on new
tickets and was no longer displaying by default in the Visit
Owner field at the top of the Admin view.

The Visit Owner appears as expected.

Billing 118337 Users were unable to add charges or transactions in cases
where there was missing Fee Schedule or Responsible
Provider information.

Users can add charges or transactions regardless of
whether a Fee Schedule or Responsible Provider is
defined.

Billing 118660 After applying v23.1 Service Layer Hotfix 2, users were
having issues posting charges by using arrow keys or the
ENTER key if there were multiple CPT codes.

You can now post charges without issue even if there
are multiple CPT codes associated with charges.

Billing 118817 Duplicate order checking was stopping after the first duplicate Duplicate order checking now continues.
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Feature KA Issue Description Resolution

alert appeared and users selected No.

Billing 118829 If a procedure had Do not multiply Quantity Units checked
in the fee schedule, the procedure would not void properly.
The units were correct, but the calculated units were not. The
calculated units were coming up as positive numbers when
they should have been negative. This was causing the total
fee of the procedure to be added instead of subtracted and
impacted the visit total.

Now, when you void a procedure with Do not multiply
Quantity Units checked, it voids as expected.

Billing 118346 The show payment amount was not saving on initial payment
posting.

The show payment amount saves as expected.

Billing 118109 When changing the facility on a visit, a pop-up warning stated
that all fees must be recalculated, even if the fee schedule
hadn't changed.

This erroneous message no longer appears.

Billing 121105 User names of billing teammembers (non-providers) were
showing up on different patient appointment activity lists as
completing visits.

Only appropriate staff who completed visits now appear
on appointment activity lists.

Billing 121273 The resource is being randomly changed from the one that
was scheduled.

Implemented a potential fix and enhanced logging in
OMS and the database during resource modifications
initiated from visits and the database.

Billing 122269 Incorrect patient data was being pulled into the wrong visit. Implemented a potential fix along with enhanced
logging in OMS to capture visit-related data during the
modify visit workflows.

Billing 126171 Authorization numbers manually entered in the Visit Info tab
for visits with workers' comp claims were not being retained.

Authorization numbers entered for workers' comp
claims are now retained.

CCDA 2.1 97213 Multiple, concurrent requests to create transition of care
documents (v2.1 CCDAs) were causing the server to stall.

This issue is corrected. Multiple, concurrent requests to
generate chart documents for exchange with other
providers no longer cause server interruptions.

CCDA 2.1 102173 When creating transition of care files, files for large charts This processing error is now corrected.
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Feature KA Issue Description Resolution

were failing to generate due to an SMPP processing error.

CCDA 2.1 111011 Previously, when users generated CCDA files for transition of
care events, lab result information was appearing in the Vital
Signs sections of these documents.

Lab result information no longer appears in Vital Signs.

CCDA 2.1 105904 Results for labs were not appearing grouped by lab order
panel as is expected.

Lab results now appear grouped by lab order panel.

CCDA 2.1 105976 When users generated CCDA documents from a patient's
chart for transition of care events, the problems listed were
not appearing in the generated files if any one of the
problems listed had a NULL value.

Now, if a problem listed has a NULL value, any other
patient problems still appear in the generated CCDA
file.

CCDA 2.1 108084 Imported CDAs occasionally showed the wrong patient name
in the document routing entry on a provider's desktop.

This issue is resolved.

CCDA 2.1 117539 The CDA Designer was not working on load balanced
systems.

CDA Designer now works on load balanced systems.

CCDA 2.1 118349 When CCDAs were imported with a Document reconcile_
status of NULL instead of “N," users were unable to reconcile
these documents.

We've ensured that imported CCDAs have the
reconcile_status attribute set to "N."

Chart 126172 Previously, the ProcessLoincExtract stored procedure was
retrieving incorrect LOINC codes.

Now, this stored procedure retrieves the correct LOINC
codes.

Chart 112840 When users selected a preferred site to retrieve Problem
information, their preference was not stored as the default
and they were required to select it again.

The preferred Problems site is retained as the default
site.

Chart 111196 Users were unable to perform LOINC code mapping to
document types.

The issue preventing LOINC code mapping to
document types is resolved.

Chart 111528 Truven Care Notes displays an error message after selecting
the language to use.

This error message no longer appears when selecting a
language.

Chart 111527 Transition of care events were not appearing in the Transition of care events now appear in the MU log as
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Feature KA Issue Description Resolution

Meaningful Use log for some patients. they occur.

Chart 113197 In rare cases, the wrong past medical history was appearing
in charts.

The system retrieves the correct past medical history
for patients.

Chart 113833 CNow was failing to display vital signs for some patients. Now, CNow displays vital signs for patients if this
information is available.

Chart 126173 The signed document DID (SDID) was not appearing in the
Document table.

These IDs now appear in the table.

Chart 114340 In rare cases, previous observation values were appearing in
the most current lab results.

This no longer occurs.

Chart 114834 Allergies with commas in their descriptions were causing
crashes.

We've introduced corrections to prevent crashes from
occurring in these instances.

Chart 76650 The insurance carrier selected for a visit was not appearing in
the visit.

The selected carrier appears in the visit.

Chart 117338 Updating the facility on a visit also updated the company if the
company was different from what users selected for a visit.

The originally selected company is retained.

Chart 117379 Smartlaunch FHIR clients, such as third-party billing systems,
were displaying an error pop-up "protocol = https host = null"
upon opening if the hostname contained "fhir."

This error message no longer appears.

Chart 117461 After v23, users were unable to backdate an order's start date
to a day prior to an active visit's clinical date.

Now, you can enter a date prior to an active visit's
clinical date.

Chart 117464 When using the percentage variance on protocol events, obs
values entered outside of this range were showing as Done,
when they were actually Due Now.

This issue is resolved.

Chart 113884 Visits were slow to open. This issue is resolved.

Chart 117995 The Clinical Visit Summary was displaying comments but
was not displaying problems in patient instructions and care

Documented problems display in the Clinical Visit
Summary as expected.

athenaPractice v25 Release Notes 4. Fixed in v25 103

80 Guest Street, Boston, MA 02135 • 617.402.1000 • athenahealth.com

https://athenaflex.athenahealth.com/s/article/000113197
https://athenaflex.athenahealth.com/s/article/000113833
https://athenaflex.athenahealth.com/s/article/000126173
https://athenaflex.athenahealth.com/s/article/000114340
https://athenaflex.athenahealth.com/s/article/000114834
https://athenaflex.athenahealth.com/s/article/000076650
https://athenaflex.athenahealth.com/s/article/000117338
https://athenaflex.athenahealth.com/s/article/000117379
https://athenaflex.athenahealth.com/s/article/000117461
https://athenaflex.athenahealth.com/s/article/000117464
https://athenaflex.athenahealth.com/s/article/000113884
https://athenaflex.athenahealth.com/s/article/000117995


Feature KA Issue Description Resolution

plans.

Chart 118130 For visits with hospitalization information, hospitalization
dates were being removed if a case was added with no dates
defined.

Hospitalization dates persist regardless of whether
added cases have dates defined

Chart 126174 When clicking through the chart module, the application
would sometimes crash with access violation "method
GEFData::act - action =."

This issue is resolved.

Chart 121304 Clients were experiencing intermittent performance issues
when accessing the chart from the main menu.

These performance issues are resolved.

Chart 120213 The Vital Signs-CCC form was automatically writing the
observation value of "No" for Overweight when this was
previously recorded as "Yes."

The previously recorded value is retained unless
manually changed by the provider.

Chart 69893 Upon completing orders, an incorrect alert appeared,
resulting in additional clicks.

This alert no longer appears.

Chart 74873 Using the option to add a new service provider to an
organization was resulting in that provider being associated
with historical orders.

New providers are not erroneously associated with
historical orders.

Chart 122318 Users were unable to remove unsigned documents due to
rows existing in the ECRACTIVITY log.

This issue is resolved.

Client 124443 After logging in, the Main Menu window does not appear and
an error is displayed.

This Main Menu window issue has been resolved.

EDI 125718 When using athenaPracticeRT to run an eligibility request,
the 271 response from the payer was not being entered into
the Notes field in Registration, and the eligibility status
remained as Pending. If Quatris was used in addition to
athenaPracticeRT, an error message "Unable to retrieve
patient insurance data" was received.

When running eligibility checks with athenaPracticeRT,
271 responses from the carrier are updated in the
Notes field in Registration, and the status is updated
accordingly based on the payer's response. If Quatris is
used in addition to athenaPracticeRT, the 271 response
is now processed correctly.

EDI 121749 The PatientStatements plug-in from the installer was not This plug-in now removes old DLLs as designed.
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removing old DLLs upon upgrading.

EDI 64477 The following error occurred while running eligibility checks
for the entire day: "Error occurred in class SEH Exception,
method CHSDialog::WindowProc - class CDlgEDIProgress
0xC00000FD." 

Large numbers of eligibility checks now complete
successfully without any crash.

Important: To enable this fix, you must configure the
CPOPM.exe.config file as shown below:

<add key="Patient-Eligibility-Batch-Mode-Enabled"
value="true" />

<add key="Patient-Eligibility-Option" value="30" />

By default, the value of these keys are set as “false” and
“0.”

Med
Management

111234 A significant increase in Medication Management pop-ups
was occurring after the v22 upgrade.

This issue is resolved.

Med
Management

101467 When creating multiple controlled substances using the "Do
not fill before" date, duplicate rows were created on the Chart
Summary.

This processing error is now corrected.

Med
Management

126168 Previously, medication and prescription MEL symbols were
not returning office comments as designed.

This issue has been resolved. Now, prescription MEL
symbols return office comments as expected.

Med
Management

102496 A pop-up message we retired in v20, reading "Prescription for
controlled substance is added. Proceeding to sign the
document without viewing patient's drug history in Controlled
Drug Report?" was still appearing.

This pop-up no longer appears.

Med
Management

126169 In some cases, the system name was not transmitting to Dr.
First, resulting in a sync error.

The system name now transmits as expected.

Med
Management

103475 The API receiving patient demographic responses from
Rcopia was not recognizing when the information received
contained errors.

Now, if the system receives demographic responses
from Dr. First that contain errors, these instances are
identified.
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Med
Management

114471 Even though an Rx was sent successfully, it was appearing in
the system as "Signed Not Sent."

Successfully transmitted prescriptions appear as
"Sent."

Med
Management

114916 After clicking Create New Rx in Med Management, users
expect the cursor to automatically appear in the drug search
field, which was not occurring.

Now, the cursor automatically appears in the drug
search field.

Med
Management

107943 Previously, if a pharmacy sent a renewal with a drug
description that did not match the description in Medication
Management, this sometimes resulted in the system creating
an additional, inactive medication entry.

Example:
A pharmacy sends a renewal request with Lipitor 10mg tablet
as the drug description.

a) The drug description in Medication Management is Lipitor
10mg oral tablet.
b) Medication Management recognizes that these are the
same drug.
c)  athenaPractice observes a difference in drug names and
proceeds to create an additional, inactive medication with the
drug description Lipitor 10mg tablet.
d)  Providers must review and manually remove these
additional, inactive medication entries.

Resolved. If a pharmacy sends a renewal with a drug
description that does not match the description in
Medication Management, the system no longer creates
a separate, inactive medication entry for the renewal.

Med
Management

93956 Previously, duplicate medication entries could occur when
users sent multiple prescriptions and then closed the
Medication Management window before the system could
send the prescriptions completely.

Now, when you close the Medication Management
window, athenaPractice immediately downloads all
medications and prescriptions from Medication
Management. This prevents duplicate medication
entries from occurring in these instances.

Med
Management

117340 Diagnoses associated with medications were not consistently
displaying in the View Medications window.

Associated diagnoses now appear in View Medications.

Med 117885 A prescription cancellation could cause the system to create Prescription cancellations no longer cause the system
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Management an additional document that contained the same clinical list
changes.

to create additional documents.

Med
Management

116921 When closing the Med Management window, if a medication
was added that does not have a corresponding ICD-10 code,
the system would check for an ICD-10 diagnosis ID and
would throw an exception if not found.

Added medications without ICD-10 diagnosis codes no
longer cause these exceptions.

Med
Management

118431 EPCS invitations to complete Identity Proofing were being
sent when new locations of care were added for an
organization. Organizations were asked to tell providers to
ignore these invitations unless they required enrollment.

Now, when a new location is created, existing users
already enrolled who are a part of that location are
added to Medication Management without receiving
invitations.

Med
Management

126167 When launching Medication Management from theManage
Medications button in a patient’s chart, the portal was not
defaulting to the Patient Info page (Medication Management
main page).

Medication Management launches with the Patient Info
page opened, as expected.

MEL 111789 ORDERS_NEW, ORDERS_AFTER, and ORDERS_ALL
data symbols (delimited) failed to return ICD codes when
users navigated to another chart and back.

These data symbols now return ICD codes for a chart,
even if a user navigates away from the chart and then
returns to it.

MEL 115379 For referral orders, MEL_ADD_ORDER was not retrieving
duration values.

MEL_ADD_ORDER can retrieve duration information
for referral orders.

MEL 118179 The LISTRXNEWFULL data symbol was returning all
prescriptions written in the chart instead of prescriptions
written in the last update.

This data symbol now returns prescriptions from the last
update as expected.

MEL 123053 The data symbols used to "round" or "truncate" values
weren't functioning as expected when the number of places
after a numerical decimal point was greater than two.

This issue is resolved.

MEL 123066 When using the "delimited" argument with the allergy ALL_
AFTER, ALL_ACTIVE, and ALL_NEW data symbols, the
allergy "Reaction" label was not pulled into the document.

This issue is resolved.
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Practice
Management

118067 In Practice Management, if the WebView2 is out of sync,
there was no way to clear or reset it.

Now, when you click Main module > Actions > Clear
Html Cache, WebView2 resets.

Registration 112747 An erroneous alert was received when saving Registration
changes.

This alert no longer appears.

Registration 112826 In some cases, the system would crash when users
attempted to save information in Registration.

This was identified as a database table issue that is now
resolved.

Reports 91755 The Test Order Crystal Report was missing modifiers when it
was run.

This report now includes modifiers when it is run.

Reports 114919 When users ran the Chart Access report and configured
settings to include INACTIVE users, these users were not
appearing in the report.

Now, when you configure the Chart Access report to
include INACTIVE users, these users are included in
report results.

Reports 117358 Users were unable to generate a good faith estimate report. This issue is resolved.

Scheduling 111076 Appointment queries were failing to retrieve appointments
containing an ampersand (&).

Queries no longer fail when an appointment includes an
ampersand.

Scheduling 110832 The green insurance eligibility check marks were only
appearing on patient appointments on the date of the
appointment.

Now, insurance eligibility check marks appear once a
patient's insurance is verified.

Scheduling 117517 Users were unable to add or update correspondence notes or
next contact dates for multiple tickets.

This issue is resolved.

Scheduling 119315 WeInfuse is an external system for infusions that sends
appointment messages to LinkLogic, which updates
appointments in the system. However, the status of these
appointments was not updating to Booked or Scheduled
when these messages were received.

Appointment messages sent fromWelnfuse now
update the status of appointments.

Subscription 97649 Interop or single JBoss services fail to start when references
to CEM subscription shutdown is in the server log.

This issue is resolved.

System 104101 The system was allowing the current database backup to be Deletions of most recent database backups are not
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Feature KA Issue Description Resolution

deleted if the SQL backup job ran past midnight. permitted, regardless of when backup jobs complete.

System 111630 CPU issues occurred when configuring multiple websites on
the server.

The server can support multiple website configurations.

System 111731 After upgrading to v22, DTS failed to run as a service. DTS runs as a service as expected.

System 126166 Some organizations requested a process or scripts to update
an athenaPractice test environment on a nightly basis.

athenaPractice now runs a nightly job to perform routine
maintenance or update tasks.

System 113997 In some cases, the data mapping functionality was crashing. Data mapping functionality works as expected.

System 119550 Security vulnerabilities were detected in Apache for v23. These vulnerabilities are patched.

System 115377 In some cases, 'Wait For File Exists Failed' errors occurred
when users attempted to fax from athenaPractice.

These errors no longer occur when faxing.

System 107657 An athenaPractice DLL stopped working when users were
inputting charges.

This DLL no longer stops working as you enter charges.

System 119550 Log4j 1.x security vulnerabilities were detected on JBoss
servers.

These vulnerabilities were addressed.

System 119759 In OpenJDK version 11.0.8, security vulnerabilities were
detected.

These vulnerabilities were addressed.

System 87487 Excessive logging was causing performance issues. The configuration that allows for verbose database
logging with no benefit has been switched off for
organizations that were using it and experiencing these
issues.

Upgrade 107744 A '403 Forbidden' error was appearing for websites launched
from Setup Links.

This error no longer appears when accessing web
pages from Setup Links.

Upgrade 120313 After upgrading to v23, MIK would not process all socket-
based or file-based messages.

This issue is resolved.

Upgrade 118922 After upgrading to v23, not all problems were appearing on
the Clinical Visit Summary documents generated by users.

All problems appear in generated Clinical Visit
Summary documents.
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Feature KA Issue Description Resolution

Upgrade 122731 Update.jsp does was not refreshing to show the latest status
of the client.

This issue is resolved.

Upgrade 123382 Organizations upgrading to v24 encountered install failure
due to a hyphen in the database name.

Hyphens in a database name no longer cause
upgrades or installations to fail.
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5. Known Issues
We publish a known issues list based on customer reports and issue severity. Not all reported issues are published as known issues. Some
issues are resolved real-time during troubleshooting while others require more in-depth research to resolve. While not every support call results
in a ticket for a fix or enhancement, every issue moves through an evaluation process. If an issue you are encountering is not listed, it may not
have met the eligibility criteria based on available information.

The known issues list is designed to inform customers of specific issues that have completed the initial triage and evaluation process. The list is
not a commitment to fix the issues. However, the list contains information to help customers determine how the issue will impact them and
how to avoid it, if possible.

Feature KA Issue Description Workaround Version
Found In

Admin 67131 When the athenaPractice and athenaFlow applications run on
the same machine, the user might get an error when they log into
either application using a standard user account in Windows.

If using Citrix, split the athenaPractice
and athenaFlow applications onto
separate servers.

OR

Add the Windows user to the local
administrator account.

12.3.1

Billing 113536 When approving a visit with athenaPractice HCM, the following
error may occur: "The URL
https://hcm.idxasp.com/axis2/services/HCMMessageManager
configured in the system is incorrect due to which the requested
URL was rejected."

In the HCM Proxy Connection
settings, add http:// to the URL in the
Address field.

1. Go to Administration > System
> Application.

2. With athenaPractice/HCM Visit
Approval selected from the

23
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Feature KA Issue Description Workaround Version
Found In

Global Approval Plug-In drop-
down menu, click Settings.

3. At the bottom of the
“athenaPractice/HCMGlobal
Approval Settings” window, add
http:// to the URL in the Address
field and clickOK.

Billing 65214 Error occurs when splitting charges for Medicare in Billing
module. After the error, the Billing module either crashes or
remains open.

No workaround. 12.3

CC Basic 86320 The folders inside C:\Program Files\Centricity Practice
Solution\jboss\standalone\deployments\ <database name>.ear\
CentricityPracticeWS.war\EncounterForms cannot be manually
deleted while JBoss is running.

These folders do not need to be deleted, but you may encounter
this issue if, for example, you want to delete folders for obsolete
CC Basic HTML forms.

Shut down JBoss before deleting the
folders.

OR

If folders need to be deleted while
JBoss is running, sequentially delete
folders starting from the lowest folder
in the structure and working upward.

19

CCDA 2.1 124820 A new feature switch (InvalidCertificateDNSValue) has been
implemented for handling invalid certificates on load balancer
machines, with the default setting being ON. When this switch is
active, you may encounter issues while completing workflows
such as CVS, TOC, or care plan document generation, smart
URL launches, external attachment workflows, and some CDA
Designer workflows on the FHIR side.

To resolve this, you can fix the invalid
certificate for the load balancer or turn
off the feature switch. Please contact
Support if you want to turn off the
feature switch.

25

CCDA 2.1 107697 An error occurs while trying to create a CCDA 2.1 document if In some cases, the proxy can be 22
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Feature KA Issue Description Workaround Version
Found In

the JBoss server tries to make a request to itself or the Interop
server and the request is routed to the proxy.

bypassed by setting the six API Web
Services* Internet Sites to use an IP
address rather than the FQDN (in
Administration > Charts > Internet
Sites).

Chart 63646 When a user clicks the down arrow to see the historical 0 to 24-
month chart in a growth chart, it's blank.

No workaround. 12.3

Chart 80939 When placing document on hold, a user cannot sign the clinical
list changes after making direct changes to the flowsheet.

Either leave the clinical list changes
unsigned and place the document on
hold or sign the document.

12.3

Chart 86336 In Windows 10, various Chart workflows cause the application to
crash if the Windows scale and layout setting is not set to 100%

Change the screen resolution:

1. Right-click on the Windows desktop
and select Display settings.

2. Under “Scale and layout," change
the size of text, apps, and other items
to 100%.

3. Restart the application.

19

Chart 62913 Old Orders appeared in the new encounter when only new
Orders should display.

No workaround 20.1

Chart Users may notice a banner stating “Patient Demographics have
changed. Please close and refresh the window for latest sync
updates,” which appears and then reappears again after the user
has already closed Med Management to refresh the chart.

Users may review patient’s
registration page for changes if
needed. Otherwise, ignore the
duplicate notification.

23

Chart When using Hospital Connect's Reconcile form and other QIE-
based Reconcile Forms during an update, the text translation is
not properly updated.

Switch to another patient and then
back to the original patient. The text
translation will display properly.

20.2
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Feature KA Issue Description Workaround Version
Found In

Chart Desktop 114945 A crash sometimes occurs when opening Chart Desktop. Logs
specify an exception inside SftTree_IX86_A_75.DLL.

Instead of opening Chart Desktop
directly, go to Registration and then
go to Chart Desktop.

23

Documentation N/A External web links not working in the new Help system. The new Help system is now
published in a cloud container, which
allows us to push changes to the Help
in real time. Because of how the Help
is hosted, external jump links are no
longer supported. To access a link to
an external site, copy the link and
paste it into your browser.

25

eCR 113510 With eCR Now, CPU usage may spike to 100%. This is due to a
huge workload on the thread pool of the eCR Now scheduler.

Update a value in
application.properties to 50% of total
CPUs configured for the eCR Now
machine as follows:

1. Stop the eCR Now application:

a. Open the Windows Services
app.

b. In the Services window,
locate and select the eCR
Now service and click the
Stop Service icon.

2. Open eCR-Now_
<DBName>\eCRNow\ecr-
now.war with 7Zip software to
update the properties inside the

23
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Feature KA Issue Description Workaround Version
Found In

ecr-now.war file.

3. In 7Zip, navigate to the subfolder
ecr-now.war\WEB-INF\classes\,
right-click the
application.properties file, and
select Edit.

4. Modify the following property
value to 50% of CPUs configured
for the eCR Nowmachine:

db-scheduler.threads=10 – This
is the existing property and its
value, which is 10.

db-scheduler.threads=<new_
value> – Modify the value to 50%
of CPUs configured for the eCR
Nowmachine. For example, if
there are 4 CPUs configured for
eCR, update the value to 2.

5. Save and close the modified file.

6. Exit the 7Zip software.

7. Start the eCR Now application:

a. Open the Windows Services
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Feature KA Issue Description Workaround Version
Found In

app.

b. In the Services window,
locate and select the eCR
Now service and click the
Start Service icon.

Help When accessing online Help, a ‘Cannot open file’ error message
appears, and the Help system fails to launch under the following
conditions:

l After importing a clinical kit.

l After generating a CSV document from the application, such
exporting a custom report as a CSV file.

l After importing custom reports in the PM reports module.

l After a LinkLogic import.

If this error message appears, log out
of athenaPractice, relaunch, and then
log back in. Press F1 or select Help >
Help with athenaPractice to access
the Help system.

23

LinkLogic 96400 A basic LinkLogic Demographics Import does not require an IXP
or XRF cross reference file unless the import needs to support
different interfaces or translate the data field values to be
recognized by the application, which needs an IXP or XRF file to
be configured. Configuring inappropriate IXP or XRF files for a
Demographics Import may lead to an application crash.

Refer to theManaging Interfaces with
athenaPractice v23 guide before
configuring the Demographics Import.

12.3.4

Medication
Management

107943 When users change the dosage of a medication in Active
Medications and then cancel the original prescription, the new
dosage appears for the canceled prescription within text
translation instead of the original dosage.

After canceling an Rx, do not make
medication changes in the same
session. Close the Med Management
window and reopen, then make
changes.

23

Medication
Management

113831 When users enter an Employer in Registration > Contacts, select
the Is Pharmacy check box in New Professional Contact, and

Select the Patient tab and then click
Change. In Change Patient, select the

23
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Feature KA Issue Description Workaround Version
Found In

then Save, attempts to change or delete the contact cause
Medication Management to launch. Users are then unable to
change or delete the contact.

Contacts tab. Select the contact in the
table and then click Change or
Remove.

Medication
Management

113834 When users update patient preferred pharmacies in Medication
Management launched from a patient’s chart and then execute
the REGPHARMACYMEL symbol immediately after to return
preferred pharmacies, the previous pharmacies appear in results
for up to six minutes after the pharmacy update occurred. This is
due to a DrFirst CEM job, which runs every five minutes to sync
cloud-stored pharmacy information with on-premises chart data.

Workaround:

a. Wait up to five or six minutes after
updating patient preferred
pharmacies in Medication
Management to run
REGPHARMACY.

- OR -

b. Launch Medication Management
from Registration > Contacts or
Registration > Insurance, immediately
close Medication Management to
trigger a refresh, and then run
REGPHARMACY.

23

Medication
Management

113836 If a patient has a custom pharmacy added as a preferred
pharmacy and a user deletes the custom pharmacy from
Medication Management for the practice (Utilities -> Pharmacy
List Maintenance -> Pharmacy search -> Remove from Practice
List), the deleted custom pharmacy continues to appear for the
patient in their Contacts list (Registration > Contacts tab).

The custom pharmacies you add to
Medication Management for a
practice will persist as long as any
patients have the custom pharmacy
added as a preferred pharmacy. To
remove completely, delete the custom
pharmacy for each patient that has it
listed as a preferred pharmacy
(Medication Management launched
from Chart > Patient Info > Select in
Pharmacy > Remove Patient

23
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Feature KA Issue Description Workaround Version
Found In

Pharmacy). Then remove the
pharmacy from the Practice list in
Utilities > Pharmacy List
Maintenance. Alternatively, providers
can verify that the custom pharmacy
is not selected as the active pharmacy
while prescribing and can delete it
from patient pharmacies when
discovered.

Medication
Management

113838 The contact details text box beside the Contacts table in the
Registration -> Contacts tab shows the details of the previously
selected contact row in the table. Details persist in the text box
even when the patient has all contacts removed.

Exit the application and log in again to
refresh.

23

Medication
Management

113815 When responding to renewals and change requests from Chart
Desktop > Pharm Msg (Multi-Patient Mode), the system
automatically signs the prescription and electronically transmits
the fill response to the pharmacy with the prescription’s details.

If the pharmacy response cannot be sent electronically and is
sent as a fax, the prescription refill information doesn’t appear in
the text translation window but does appear in the patient’s
Medications list and in Clinical List Changes. This is an issue
only for renewal responses that are sent from Chart Desktop >
Pharm Msg. This is not an issue if the renewal was started from
the patient chart.

View the full clinical list changes by
right-clicking on the document. Copy
the text and append it to the
document.

23

Medication
Management

113816 When responding to renewals and change requests from Chart
Desktop > Pharm Msg (Multi-Patient Mode), if the prescription
does not complete and is pending a provider signature (e.g., a
clinical user who is not assigned as an agent or an agent
renewing a controlled substance tries to send a response), this
pending prescription will not appear in Prescription Status. This

Respond to refill requests by
launching Medication Management
from within the patient’s chart.
Alternatively, have the provider or an
agent assigned to the provider

23
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Feature KA Issue Description Workaround Version
Found In

is because a pending prescription must be generated from a
chart document to appear in Prescription Status and activities in
Pharmacy Messages that haven’t reached a final state do not yet
have a chart document.

respond, ensuring the prescription
was sent successfully as confirmed
by the green notification after
sending. If you do respond to refill
requests for other providers from
Pharmacy Messages, remove the
alert generated for the event in Alerts
and Flags. The pending prescription
will not appear in Prescription Status.

Run the Pharmacy Responses
reports to identify messages with
pending or unsigned prescriptions
that require additional action. In
Reports, expand theMedicaLogic
folder and selectMed Management.
In Print Items, select Pharmacy
Responses by Prescriber or
Pharmacy Responses by Sender,
select the users to include, and click
Print or Preview. Scan the Doc ID
column of the report. Blank fields
indicate pharmacy messages with
pending/unsigned prescriptions.

Medication
Management

93904 If you access Medication Management and your JBoss server’s
time is ahead or behind the official time by more than 30
seconds, the following error displays:

SSO-209: The time value is missing or invalid.
This issue can occur if Windows Server is not set up properly for
Network Time Protocol (NTP) sync or is prevented from
contacting the configured NTP server.

Adjust your JBoss server’s time to
within 30 seconds of the official time
for your time zone. To see how far off
your clock is, go to
https://www.time.gov/ from the server.

20
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Feature KA Issue Description Workaround Version
Found In

Medication
Management

96402 If a hard crash occurs with Medication Management open, an
error occurs upon signing a document with an existing
medication that was renewed in Medication Management.
“Cannot sign this document. Clinical data synchronization in
progress.” This indicates that a synchronization error is being
prevented.

Select End to the right of the
document. In End Update, select
Hold Document, Sign Document, or
Cancel. Open the Medication
Management module and then close
it.

See Resolving synchronization error
due to outage for detailed workflow
information.

20

Medication
Management

67921 For organizations using SMPP only with the application, we no
longer recommend entering Cell as a patient phone type. SMPP
does not recognize this as a valid type and will default to the
patient’s home or work phone if encountered. Enter Mobile as
the phone type for patient cell numbers.

Enter Mobile as the phone type
instead of entering Cell.

20

MEL 113841 MEL symbol GET_USER_LIST_BY_SPECIALTY only returns
results if users enter ‘SPECIALITY’ in the symbol, which is the
British spelling of specialty. The symbol should return results if
users enter the US spelling, which is ‘SPECIALTY.’

Until resolved, enter GET_USER_
LIST_BY_SPECIALITY instead of
GET_USER_LIST_BY_SPECIALTY
to return results.

22

MEL 113484 HCC_AFTERMEL symbol returns unsigned changes from other
chart documents. This is a deviation from the existing *_AFTER
MEL symbol behavior.

No workaround. 23

MEL 96403 When the time zone of the SQL and JBoss servers are not
properly set to ET, CT, MT, or PT with auto-adjust for daylight
saving time, this can cause incorrect results from the
MEDSPRIORMEL symbol. The timestamps from an
unsupported times zones can result in returning medication
updates from the current chart update as well as the prior
update.

No workaround. 20
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Feature KA Issue Description Workaround Version
Found In

Registration 63667 When a user has Quick Entry Mode enabled in Registration
Preferences, the Save & Continue button does not save
changes to the Patient Data Authorized check box.

In Quick Entry Mode, click Save
before clicking Save & Continue to
save changes to the Patient Data
Authorized check box.

OR

Disable Quick Entry Mode.

12.3.3

Reports 107683 Printing from Practice Management Reports is slow when using
Crystal Reports .NET.

Preview the report and print from the
Preview Report window instead of
printing directly from the report.

Note: This workaround is applicable
only for users who have activated
Crystal Reports .NET.

22

System 113481 If you do not have Internet Explorer (IE) installed or have
completely uninstalled IE from your environment, you may not be
able to view the Support links such as Webex Connect on the
main athenaPractice menu.

Access the Support links using the
following URLs in any web browser in
your environment.

Webex Connect:
http://athenahealth.webex.com/

Application Variables:
https://[hostname]:9443/
[DatabaseName]/cps/support/app_
status.jsp

Browser Capabilities:

23
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Feature KA Issue Description Workaround Version
Found In

https://[hostname]:9443/
[DatabaseName
]/cps/support/browser_cap.jsp

HTTP Server:
https://[hostname]:9443/
[DatabaseName
]/cps/support/server.jsp

Screen Capabilities:

https://[hostname]:9443/
[DatabaseName
]/cps/support/screen_cap.jsp

Workstation 92844 When viewing the application on high-resolution screens, such
as 4K displays, boxes may appear small, buttons or titles may be
clipped, selected display areas may be unviewable, or other
controls may not be accessible.

If you are experiencing display issues:

1. Right-click on the desktop and

select Display settings.

2. Under “Scale and layout," change

the size of text, apps, and other

items to 100% and set the

Resolution to either 1920 x 1200 or

1280 x 1024.

3. Restart the workstation.

19
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Feature KA Issue Description Workaround Version
Found In

With these settings, the application
should be scaled to optimal size. You
may still experience some display
clipping, sizing, or other unusual
behavior depending on the screen
being used.
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6. Getting Technical Support
If you require help, contact your Value Added Reseller or Services at 888.436.8491 option 1 or online via the
Customer Portal.

You can join online communities related to your product and features and view the latest communications,
product postings, and other implementation resources.

1. Log in to the Customer Portal for your product, and in the top navigation bar, click Groups.

2. Under Available Groups, select a group you want to follow.

3. Click Join Group. You’ll receive a weekly digest email update when new items are posted to a group you joined.

4. To change how often to receive email updates, visit each joined community and click the Weekly Digest email icon

the upper right corner. Then select a frequency: Weekly Digest (default), Daily Digest, Every Post, or Limited.

5. To view the latest communications online, log in and select a group name.
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